
Everything You Need  
Is Right Here.

QWEST CHOICE™ ONLINE 
QWEST CHOICE™ TV

Welcome Kit



� | QWEST CHOICE ONLINE AND QWEST CHOICE TV WELCOME KIT

In order to provide television and online service to you, we maintain 
business records that contain certain information about you.

I.�	� This information includes your name, address and telephone 
number; information about the services you subscribe to use; 
information about the equipment used to provide service to you; 
and accounting records reflecting payments you have made 
for services (“personal account information”). Except in the 
following circumstances, we do not make such personal account 
information available to others without your permission.

•	� Where necessary to perform maintenance or repair services, 
we may make your name, address, telephone number or 
services and equipment information available to qualified  
repair contractors or engineers

•	� To perform auditing, bookkeeping, billing and collection functions, 
we may also make personal account information available to 
accountants, program providers, computer service bureaus and 
others engaged in maintaining, auditing or reviewing our financial 
records, and in the billing collection of accounts 

•	� When necessary to render services and related services to 
our subscribers, Qwest Choice™ TV & OnLine may also provide 
personal account information to other outside agents such 
as cable program guide distributors, customer satisfaction 
polling services or system testing services who assist us in 
providing service 

•	� Qwest® is required to provide appropriate personal account 
information to governmental agencies if a court order is issued 
requiring us to do so. Unless directed not to, we will promptly 
inform any affected subscriber if we receive such an order 

II.	�From time to time, Qwest may alert you by mail or telephone 
about our services or about other products and services that we 
think will interest our subscribers. Some of these offers will be 
for products or services we think may be of particular interest 
to you, based on the type of Qwest Choice TV & OnLine services 
that you purchase. On occasion, we are also asked by charities 
or businesses for the names, addresses and telephone numbers 
of subscribers to one or more of our services, so that those 
entities can contact subscribers to seek charitable contributions 
or to make offers of products or services. Qwest’s general policy 
is not to provide this information to others, although we can 
make certain exceptions where we believe the matter may be of 
particular interest to our subscribers. If you do not wish for us to 
disclose your name, address and telephone number to others for 
purposes not related to Qwest’s services, please contact us at the 
appropriate customer service number on the next page.

Qwest Choice™ TV and OnLine Services
Customer Privacy Policy

Our business records contain information about our subscribers.
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III.	�Our business records containing personal account information 
are retained for the period that an individual remains a Qwest 
Choice TV & OnLine subscriber and are destroyed after the 
individual ceases to be a subscriber, all billing and collections 
functions are completed, and record retention periods imposed 
by law have elapsed. Qwest employees, contractors and 
agents are permitted access to personal account information to 
maintain and repair your account, manage our overall network 
and business operations, and to provide you with Qwest products 
and services. When Qwest agents or contractors access 
or use personal account information, they are bound by the 
same confidentiality commitments that Qwest makes to you 
here. They are fully trained in their obligation to maintain the 
confidentiality of such information and to prevent access by 

unauthorized persons. 

IV.�You have the right to examine all personal account information 
that Qwest maintains. If you believe any of the information in  
our records is incorrect, we will make every reasonable effort  
to correct any error. Call the appropriate number below. 

	 Denver: 1 303-383-9400 
	 Salt Lake Valley: 1 801-741-0300

V.	� Federal law [47 U.C.S. 55 (f)] provides that, in addition to other 
remedies, subscribers to Qwest Choice TV & OnLine who believe 
their federal rights have been violated may institute civil suit 
in federal court. Remedies for violation of such rights include 
actual damages or liquidated damages (of up to $1000), punitive 
damages and reasonable attorney fees and costs.

Qwest Choice TV & OnLine is committed to protecting your privacy 
rights. Qwest encourages you to regularly review these privacy 
rights online at qwest.com/legal/privacy or qwest.com/legal/
choice_privacy.html as these rights are updated from time to time. 
Your continued use of the Service(s) constitutes your acceptance 
of any changes.  To view the broader Qwest Privacy Policy with 
respect to noncable information, visit our Web site at qwest.
com/legal/privacy.html. If you have any questions or concerns, 
please contact us immediately at the local number below. This 
document applies only to Qwest and to providers under contract to 
Qwest. Remember that the global Internet is not owned, managed 
or controlled by Qwest. Each Internet Service Provider sets and 
manages their own customer information policies. Qwest strongly 
recommends that you exercise appropriate caution in sharing 
personal information with service providers.

Customer Privacy Policy
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On-time service calls

We are committed to making our installation and service appointments 
fit your schedule. Installation appointments are scheduled at your 
convenience for a four-hour window. Repair appointments are 
scheduled for a specific time. In either case, if for any reason 
we’re not there within 30 minutes of the close of the scheduled 
appointment, you’ll receive a $20 credit on your next bill.

Rapid response 

If you ever experience a problem with your online service, just call 
us any day before 6 p.m., and if it’s a problem with the Qwest® 
network, we’ll fix it the same day. Call after 6 p.m., and we’ll have 
it corrected by 11 a.m. the next day. If it is determined by Qwest 
that Qwest is responsible for the problem, we will credit you for the 
period of the outage. 

One-stop shopping

Get your Internet and local telephone service from one convenient 
source — and see all your monthly charges together on one  
itemized bill. Call us for details and to find out about our convenient 
payment options. 

Colorado Customers 
Where to send your payment:

If you’re a Qwest telephone customer and:

Your bill is over $100:  
Qwest RPS Center 
Denver, CO 80244

Your bill is under $100: 
Qwest
P.O. Box 173754  
Denver, CO 80217-3754

If you’re not a Qwest telephone customer:
Qwest
P.O. Box 29025 
Phoenix, AZ 85038

Utah Customers 
Where to send your payment:

If you’re a Qwest telephone customer and:

Your bill is over $100: 
Qwest Communications 
P.O. Box 29060 
Phoenix, AZ  85038-9060

Your bill is under $100: 
Qwest Communications 
P.O. Box 29013 
Phoenix, AZ  85038-9013

Guarantees

Our service guarantees mean you can always expect the best service  
at a terrific value.
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Guarantees and Licensing

Cable Licensing Authorities

This list of local licensing authorities is provided for the convenience 
of our customers. These cities and counties have approved or are 
considering Qwest’s request for a license, allowing the delivery of TV 
and online service to homes within their city or county boundaries.

Please call the Qwest Choice™ OnLine & TV offices with any questions 
or problems that you may be experiencing with your service. Our goal 
is your complete satisfaction. If for any reason you are not satisfied 
after speaking with us about your Choice TV service, you may call your 
local city or town’s cable television contact listed here. 

Colorado
City of Lone Tree 
City Manager Administrative Office 
9777 S. Yosemite Street; Suite 700 
Lone Tree, CO  80124 
(303) 708-1818

Utah
South Jordan City Offices 
Administrative Offices 
1600 West Town Center Drive 
South Jordan, UT  84095 
(801) 254-3742

Satisfaction

Use Qwest Choice OnLine for 30 days — if for any reason you’re not 
satisfied, we’ll credit your account for your regular monthly charges. 
Installation charges are not refundable. If you ever have concerns 
about your Qwest Choice OnLine service or Qwest telephone services, 
please call us and we will answer your questions right away. If you 
have a concern with your bill, please call us. We’ll be happy to explain 
the charges that have appeared on your bill, as well as investigate any 
charges you feel have been wrongly applied.

Copyright © 2006 Qwest. All Rights Reserved.

Qwest Choice OnLine is a registered trademark of Qwest.

Information contained in this document is subject to change without 
notice. Qwest, their vendors and affiliates assume no responsibility 
for any errors that may appear in this document, nor liability for any 
damages arising out of the use of this document. No part of this 
document may be reproduced in any form by electronic or mechanical 
means (including photocopying, recording, or information storage and 
retrieval) without permission in writing from Qwest.

Other trademarks are the property of their respective owners. All other 
products or company names are used for identification purposes only, 
and may be trademarks of their respective owners.

Qwest Choice TV services are governed by Terms and Conditions, 
which are located at qwest.com/legal. Qwest routinely updates the 
Terms and Conditions from time to time. Your continued use of the 
Service(s) constitutes your acceptance of any changes.

Version: January 2006
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Qwest Choice OnLine Features

SECTION 1

Qwest Choice™ OnLine Deluxe 
Features Overview

•  Unlimited high-speed Internet access

•  Always one click away

•  Downstream data rate: up to 5Mbps or up to 10Mbps

•  Upstream data rate: up to 1Mbps

•  E-mail accounts: five

•  �Personal Web space: 20MB storage space and 2000MB transfer 
bandwidth per month

•  Maximum number of computers supported: four

•  �Domain hosting of e-mail and personal Web site: Vanity domain 
for Web site and e-mail convenience

•  Dial-Away Roaming access*: Yes

* �Available in select locations in the 14-state Qwest® region. Long-distance charges  
may apply when you connect from outside the local calling area or from outside the  
Qwest region.
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Support plus

Qwest Choice OnLine gives you more than just lightning-fast Internet 
access. You also receive round-the-clock technical customer support 
when you need it, 24 hours a day, 365 days a year, and professionally 
trained support technicians.  OnLine support is also available via  
e-mail at choice@qwest.com as well as Help, How To and FAQs on  
the home page Web site.

Local customer home page

Each city where Qwest Choice OnLine is available has a dedicated 
Qwest Choice OnLine home page, with local content, Qwest 
Choice™ TV listings and useful Internet tools. This home page is also 
your link to the Account Manager, where tasks such as adding e-mail 
accounts and setting passwords can be accomplished.

Qwest Choice OnLine Features
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Features defined

Personal e-mail

Qwest Choice™ OnLine Deluxe 

Every customer receives unique, personal e-mail accounts. 
Incredibly easy to use and reliable, e-mail is also very fast, usually 
taking just a few seconds to deliver your message. The Account 
Manager provides a simple way to update your e-mail address, 
change your password and more. E-mail addresses are in the 
format username@qwest.net and can contain from three to 16 
characters for the username, which you can customize as you wish 
the first time you log in to the site. You will need to choose a unique 
username for each user account you activate.

Personal Web space

Qwest Choice OnLine Deluxe – 	
20 MB storage space, 	
1000 MB a month transfer limit

Personal Web page space is maintained on our servers so you can 
put up to several megabytes of information about you and your 
family, including pictures, letters, contact information and more.  
Your Web page is viewable by everyone on the World Wide Web! 

Note: Qwest® will not allow posting of obscene or otherwise 
offensive material as determined solely at our discretion. Qwest 
will not allow posting of materials that infringe or misuse our trade 
names, trademarks or copyrights. Qwest is not responsible for the 
content of your Web site, including, but not limited to, materials that 
may infringe on others’ marks. Qwest reserves the right, at our sole 
discretion, to remove Web site content on its servers that it finds to 
be obscene, offensive or otherwise unlawful. Additional information 

is available on the Terms and Conditions page, and the Acceptable 
Use Policy is available at qwest.com/legal or refer to section 4, 
Acceptable Use Policy.  

USENET newsgroup access

Qwest Choice OnLine gives you access to discussion groups and 
bulletin boards used by people around the world. With USENET News, 
you can join discussions of over 20,000 topics, from car-buying to 
computers, investing to education and sports. If you have a hobby, 
you can almost always find others who share your interests.

World Wide Web, FTP, Telnet and IRC

Our full-service high-speed Internet access means that you have full 
access to view Web pages on the World Wide Web as well as full file 
transfer protocol (FTP) access for downloading and uploading files 
on the Internet, using your own browser. You may also use client 
software to run IRC and Telnet sessions. Note: The Qwest Choice 
OnLine Acceptable Use Policy disallows the operation of Internet 
servers and FTP servers on the Qwest Choice OnLine connection. 
For more details, please consult Section 4, Acceptable Use Policy.

Dial-Away Roaming service

Your Qwest Choice OnLine service includes traditional dial-up 
access into the Qwest.net local dial-up access ports from selected 
locations throughout the 14-state region Qwest serves. This includes 
dial-in access when you are away from home and want to check 
your e-mail and surf the Web.*

Qwest Choice OnLine Features
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Qwest Choice OnLine Features

Vanity domain name

Qwest Choice OnLine Deluxe users receive free domain name 
service for their account. Note: You are responsible for any fees 
associated with registering your domain name with InterNIC. 

Domain names are easy-to-remember words that represent 
locations on the Internet, such as www.qwest.net. If you have 
a domain name registered with InterNIC, Qwest will allow you 
to map the domain to your e-mail user accounts to create 
username@yourdomain.com, instead of username@qwest.net  
for your e-mail address. DNS service is also mapped to your 
personal home page Web space, so instead of a personal home page 
address such as:  www.users.qwest.net/~username  
You will have: www.yourdomain.com

If you do not have a domain name, you can use your Qwest Choice 
OnLine home page to order a domain name from InterNIC. This 
feature can be located by clicking on the My Account link from the 
Qwest Choice OnLine home page. If you want the service, the cost 
for the domain name (about $70) is billed directly to you by InterNIC. 
Qwest is not responsible for this process or payment.

Multiple computer access 

Qwest Choice OnLine Deluxe customers can have up to four 
computers per household set up for simultaneous Internet access 
(per-computer installation fees apply — call your local Qwest  
Choice OnLine service center for details).

*�Access using dial-up numbers outside the local calling area may incur  
long-distance charges.
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Minimum System Requirements

SECTION 2

Windows®

•	 Pentium class processor or better

•	 200MHz processor speed or better

•	 32MB of RAM or better

•	 Functional CD-ROM drive

•	 Functional floppy drive

•	 Built-in Ethernet or available PCI expansion slot 

•	� Supported Windows operating systems: 
Microsoft Windows 98 SE 
Microsoft Windows ME 
Microsoft Windows XP 
Microsoft Windows NT 4.0 Workstation 
Microsoft Windows 2000 Professional

•	 150MB of hard disk space

Macintosh®

•	 Power PC processor or better

•	 32MB of RAM or better

•	 Functional CD-ROM drive

•	 Built-in Ethernet or available expansion slot

•	 MacOS version 8.6 or higher

The computer must be in stable operating order for the installation 
to be performed. Computers with existing chronic operating system 
or hardware problems cannot be installed until the owner resolves 
any existing issues.
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The following are not supported:
•	� Any operating system not listed above as supported. Other 

operating systems can be configured by experienced owners,  
but will not be supported by Qwest®.

•	� “Multi-homed” systems (i.e., systems connected to more than one 
ISP simultaneously or with multiple Ethernet cards installed in them)

•	� Systems with existing network settings from which the customer 
will not or cannot authorize their removal. Usually, this kind of 
computer is an employer-issued portable that is connected to 
an Ethernet network at the owner’s place of employment. In 
many cases, altering the settings to allow this kind of computer 
to access the Qwest Choice™ OnLine network results in an 
interruption of the computer’s ability to connect to the existing 
network at the owner’s place of employment.

•	� Prerelease or beta versions of operating systems, hardware or 
application software

•	� Any computer that does not support the addition of Ethernet 
capability (i.e., no expansion slots)

Minimum Security Requirements
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System security

Qwest Choice™ TV services are governed by Terms 
and Conditions, which are located at qwest.com/legal. 
Qwest® routinely updates the Terms and Conditions 
from time to time. Your continued use of the Service(s) 
constitutes your acceptance of any changes. 

Staying safe when you’re on the Internet is not only important,  
it’s relatively easy to do. 

Remember, we will never ask for your password or any other 
personal information through e-mail, and neither should anyone 
else. Since you are a Qwest subscriber, we have your phone 
number. If we have a question, we will call you. If we can’t reach 
you, we will e-mail you to find a time when it is convenient to 
contact you. If you do get e-mail asking for personal information, 
your best course of action is to call us to confirm that Qwest is  
the one asking.

Do not accept files unless they come from someone you know 
and trust. Like the real world, there are a lot of nice people in 
cyberspace, but a few people are not so nice. And sometimes, 
even when the nice people have the best of intentions, they can  
still cause you some trouble.

How Qwest Choice Online Security compares

Is Qwest Choice™ OnLine as secure as traditional dial-up ISPs 
(Internet Service Providers)? We have similar security measures as 
dial-up ISPs, and we use firewall routers for added protection.

Can other Qwest customers access my computer and steal or 
delete files? Not by design. However, you can allow access to your 
computer as you desire. The Internet can allow people to access 
your computer, but you decide what level of access to give them. 
Generally, defaults are set to deny most access.

Parental control software

“Parental control” is the phrase often associated with software used 
to perform services such as site-blocking, language filtering and 
limited security features. Qwest feels strongly that parents should 
have as many tools as possible to ensure their children have a great, 
healthy online experience.

Internet Security

SECTION 3
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Giving out information

On the Internet, you will be inundated with requests for information 
about you. Most of this information is used to provide custom-
tailored services and products catered to your tastes. It is up to you 
to decide when and what information you release on the Net.

We recommend you set an information policy early on for your 
family and household. Determine what information you will and will 
not give out. This is especially critical if you have children in your 
home. Children should never respond to requests for information 
from people or anonymous users they don’t know and that you have 
not approved. It is important never to give out their names, ages, 
addresses or phone numbers, no matter who asks.

Finally, we suggest you choose sites you are comfortable with before 
giving out important information. If you choose reputable sites from 
solid vendors, you are more likely to feel secure about giving out 
your personal information and credit card numbers—just like in the 
real world.

computer Viruses

Qwest is providing the information below for customer service  
and education purposes only. Qwest assumes no liability for use  
of such information.

What is a computer virus?

A virus is a program or programming code that replicates by being 
copied or initiating its copying to another program, computer boot 
sector or document.

•	� Viruses can be transmitted as attachments to an e-mail or in a 
downloaded file, or can be present on a diskette or CD

•	� The immediate source of the e-mail, downloaded file or diskette 
you’ve received is usually unaware that it contains a virus

•	� Some viruses have an effect as soon as their code is executed; 
other viruses lie dormant until circumstances cause their code to 
be executed by the computer

•	� Some viruses are benign or playful in intent and effect (e.g. 
“Happy Birthday, Ludwig!”). Others can be quite harmful, erasing 
data or causing your hard disk to require reformatting

What is a worm?

A worm is a virus that replicates itself by resending itself as a e-mail 
attachment or as a part of a network message.

Where can I get anti-virus software?

You can get anti-virus software from most computer retailers, 
through an online search or by visiting one of the anti-virus vendor 
Web sites provided below. Qwest is providing the information below 
for customer service and education purposes only. Qwest assumes 
no liability for use of such information.

Windows (IBM compatible)
•	 Norton Anti Virus 2005 from Symantic

•	 McAfee Virus Scan from McAfee

Macintosh
•	 Norton Anti Virus for Macintosh from Symantic

•	 McAfee Virex® from McAfee

Internet Security
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SPYWARE

What is Spyware?

Spyware and Adware are software programs that gather 
information about you and your computer system without your 
consent or knowledge.

•	� This information is commonly used to profile you for targeted 
advertising, but Spyware can also gather important information 
such as e-mail addresses, passwords and credit card numbers.

•	� Other forms of Spyware called “browser hijackers” redirect you  
to different Internet sites when you are surfing the Internet.

What are some of the symptoms of Spyware?

If you experience any of the following problems, you may have 
Spyware running on your computer:

•	 Slow Web browsing or connection speeds

•	 Computer runs slowly

•	 Pop-up ads appear whether or not you are browsing the Internet

•	 Your Web browser homepage has changed or keeps changing

•	 Web sites redirect while browsing the Internet

•	 Search toolbars appear in your Web browser

•	� New software that you did not install appears in your start menu 
or desktop

What can I do to protect myself from Spyware?

We recommend you remove this software from your computer. 
Removing the Spyware application will make your computer 
more secure, help protect your privacy and improve your overall 
computer performance.

How do I get more information or help?

For more information or help protecting your computer and removing 
Spyware, visit these sites:

•	 Microsoft

•	 Webopedia

•	 SpyChecker

•	 SpyWareBlaster

•	 SpyWareGuard

Internet Security
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Acceptable Use Policy.  All use of the Services will comply 
with the AUP, posted at qwest.com/legal/. Among other things, 
the AUP prohibits sending unsolicited e-mail messages, including 
bulk commercial advertising or informational announcements 
(collectively, “Spam”).  Qwest® may immediately terminate or 
suspend any account which Qwest believes is transmitting or is 
otherwise connected with any Spam. Further, Qwest may hold you 
liable for Qwest’s actual damages in any way arising from, or related 
to, any Spam transmitted by or in any way connected to you or 
your account, to the extent such actual damages can be reasonably 
calculated.  If actual damages cannot be reasonably calculated, you 
agree to pay Qwest liquidated damages of five U.S. dollars ($5) for 
each piece of Spam transmitted from or otherwise connected with 
you or your account.  You will not, however, be liable for actual or 
liquidated damages arising from Spam generated from you or your 
account if you establish that the Spam was sent as a result of a 
virus or worm or other malicious software infection and if you have 
taken reasonable actions to prevent and resolve such infections and 
stop the Spam.

Acceptable Use Policy

SECTION 4
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Configuring Your Computer

SECTION 5

Network setup

This section gives you step-by-step instructions for the network 
(TCP/IP) setup for the following operating systems:

•	 Windows 98, ME, XP

•	 Windows NT Workstation

•	 Windows 2000 Professional

•	 Macintosh OS 8.6 or higher

What you need

The following are components necessary for Internet service in the 
case of reinstallation or troubleshooting:

•	� A personal computer that meets the Qwest Choice™ OnLine 
minimum specifications 

•	 A supported operating system 

•	 A Web browser

•	� A working network interface card (Ethernet, 10baseT); follow 
manufacturer’s installation instructions. 
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TCP/IP in Windows 98, ME, XP

Where to look

Go to the Start Menu>Settings>Control Panel and double-click the 
Network icon. This will load the Network Applet Panel for Windows 
95/98, as in Figure 1.

What to look for

Under the Configuration tab of the Network window, you will see a list 
of network components installed on your machine. In order for your 
computer to utilize Qwest Choice OnLine, you need two components:

•	� An Ethernet adapter. This may also be labeled “Network Adapter” 
or “NIC.” Popular brands include 3com, NetGear and Novell.

•	� The TCP/IP protocol. If you only have one adapter of any kind 
installed, the TCP/IP protocol will be named “TCP/IP.”

If you have another or multiple adapters installed in your machine 
(modem, second NIC, virtual private networking adapter), confirm 
that TCP/IP is listed and followed by the name of your Ethernet 
adapter (i.e., TCP/IP => PCI Fast Ethernet DECchip 21140 		
Based Adapter).

Figure 1

Configuring Your Computer
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Verifying TCP/IP

If both network adapter and TCP/IP are installed, you may want 
to confirm that TCP/IP is configured correctly. Under Network 
Components Installed, select TCP/IP (for your network card). 

Then select Properties. Select each of the following tabs from the 
TCP/IP properties window and check configuration.

•	� Under the IP Address tab (Figure 2), select “Obtain an IP address 
automatically” (DHCP)

•	 Under the DNS Configuration tab (Figure 3), select Disable DNS

•	� Under the Bindings tab (Figure 4), uncheck any checked boxes. 
You will be prompted to confirm that you have not chosen any 
bindings and asked whether you wish to select one at that time. 
Choose No (Figure 5)

•	� Under the Gateway tab, nothing should be listed. Remove any 
entries that appear

Figure 2

Leave other tabs with their default settings.  If you made changes, 
click OK and restart when prompted. If you did not make any 
changes, click Cancel.

Figure 3

Figure 4

Figure 5

Configuring Your Computer
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Configuring Your Computer

Testing your TCP/IP connection

After confirming your network settings, you can check to see 
whether you’re talking to Qwest’s online servers. If everything is 
working, you will be able to obtain an IP address. 

•	 Select the Start Menu/RUN, type “winipcfg” and click OK

•	� In the IP Configuration window (Figure 6) use the drop-down 
menu to select the name of your Ethernet card

When your computer has a connection, you will have values for 
IP Address, Subnet Mask and Default Gateway. If you do not have 
values for all three categories, it will look like Figure 7.  

Figure 6

To try to obtain an address, click the Renew button and wait for your 
computer to obtain values for the three categories. If your computer 
is unable to obtain values for all three categories, your networking 
is not configured correctly or needs further service. You will see an 
error message like the one shown in Figure 8.

Figure 7

If you are unable to obtain an IP address, you are certain your 
Ethernet card is installed properly, and your connection between 
your computer and 	the Gateway or Etherset is good, contact the 
Qwest® Help Desk for further assistance.

Figure 8
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TCP/IP in Windows NT 4.0 Workstation

From the Windows desktop, right-click on the Network Neighborhood 
icon and choose Properties, or go to the Network Control Panel 
(Figure 9).

Figure 9

•	� Click on the Protocols tab (Figure 10). If there are no protocols 
installed, the window will be blank. This lists all the currently 
installed networking protocols on your computer 

Figure 10

If TCP/IP is not already present, click on Add...to add the protocol.  
The window that opens will look like Figure 11.

Figure 11

•	� Scroll down and select TCP/IP. The computer may need access to 
the Windows NT work-station CD. Once you have added TCP/IP, 
the system will return you to the Protocols tab. Click on TCP/IP, 
then click on Properties. The window that opens will look  
like Figure 12

Figure 12
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•	� Click on the Adapter pull-down menu and verify that the only 
adapter listed is the one you have installed or are working 
with. Remove any existing gateway, subnet mask or IP address. 
Select “Obtain an IP Address from a DHCP server.” Click on the 
Advanced button. The window that opens will look like Figure 13

Figure 13

•	� Remove any existing gateways, uncheck Enable PPTP Filtering 
and uncheck Enable Security 

•	� Click OK to return to the previous window. Click on the DNS tab. 
The window that opens will look like Figure 14

Figure 14

Verify that the host name matches the computer name specified 
earlier. Remove any and all DNS server information, along with any 
domain suffix search order information.

•	� Click on the WINS Address tab. The window that opens up will 
look like Figure 15

Figure 15

•	 Remove any WINS server addresses. Leave them blank

•	� Click OK to return to the Network Control Panel, then click OK 
again to commit the changes. The computer will need to access 
the Windows NT Workstation CD. You will be prompted to restart. 
Restart the computer
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Testing the TCP/IP configuration
•	� Open a command prompt. Click on the Start menu, then choose 

Run. Type “command” in the window that opens, then click OK, as 
shown in Figure 16 

Figure 16

A window with a command prompt will open up. (See Figure 17.)

Figure 17

•	� Type “ipconfig” at the command prompt and hit ENTER. 
Something like Figure 18 will appear. Note: If the dial-up adapter 
is installed, you will see more than one IP configuration. Only pay 
attention to the Ethernet adapter and its settings

Figure 18

•	� If you get the response “No IP address” and/or “No Default 
Gateway”, try to renew the settings. Type “ipconfig/release” and 
hit Enter. Then type “ipconfig/renew” and hit Enter. Your screen 
should look like Figure 19

•	� If you are unable to release or renew, verify that your Ethernet 
card is installed properly and that the wiring between the Ethernet 
card and the Gateway or Etherset is good. Contact the Qwest® 
Help Desk for further assistance

Figure 19
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TCP/IP in Windows 2000 Professional

Windows 2000 should install TCP/IP by default when the Ethernet 
card is installed. To verify the presence and configuration of TCP/IP, 
right-click on the My Network Places icon and choose Properties 
from the menu that appears. The window that appears will look 
like Figure 20.

Figure 20

•	� Right-click on Local Area Connection and choose Properties 
from the menu that appears. The window that appears will look 
like Figure 21

Figure 21

•	� If “Internet Protocol (TCP/IP)” does not appear, then click on  
the Install... button to add it. The window that appears will  
look like Figure 22.

Figure 22

•	� Click on Protocol to select it, then click on Add... The window that 
appears will look like Figure 23

•	� Click on TCP/IP to select it, then click on the OK button to 
proceed. (In Figure 23, TCP/IP is not in the list because it has 
already been installed. On a computer without TCP/IP installed, 
it will be an option.)

 
Figure 23
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Depending on the state of the operating system, you may or may not 
be prompted to restart after the system is done copying files. If you 
are not prompted to restart, it should be possible to proceed with 
TCP/IP configuration.

•	� From the window shown in Figure 24, double-click on Internet 
Protocol (TCP/IP)

Figure 24

The window that appears will look like Figure 25.

•	� Select “Obtain an IP address automatically” and  “Obtain DNS 
server address automatically”

Figure 25

•	� Click on the Advanced... button. The window that appears will 
look like Figure 26 

Figure 26

•	� Click on the DNS Tab. The window that appears will look  
like Figure 27

Figure 27
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•	� Verify that there are no entries in any of the text boxes on this 
tab. Click on the WINS tab. The window that appears will look 
like Figure 28

•	 Verify that there are no entries in the WINS Addresses text box 

•	� Click OK when you are done. Click OK on the remaining windows 
to exit back to the desktop. You may be prompted to restart 

Figure 28

Testing the TCP/IP connection

To open a command prompt, click on the Start menu, then choose 
Run. Type “command” in the window that opens (Figure 29), then 
click OK.

Figure 29

A window with a command prompt will open up, as shown  
in Figure 30.

Figure 30

•	� Type “ipconfig” at the command prompt and hit ENTER. Your 
screen should look like Figure 31. Note: If the dial-up adapter is 
installed, you will see more than one IP configuration. Only pay 
attention to the Ethernet adapter and its settings

•	� If the message “No IP address” and/or “No Default Gateway” 
appears, try to renew the settings

Figure 31
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•	� Type “ipconfig / release” and hit Enter. Then type “ipconfig / 
renew” and hit Enter. The screen will look like Figure 32

•	� If you are unable to release or renew, verify that your Ethernet card 
is installed properly and that the Gateway or Etherset is connected. 
If you need further assistance, contact the Qwest® Help Desk

Figure 32

TCP/IP in MacOS 8.6 or higher

Be sure TCP/IP is installed and configured on your computer. 
TCP/IP is the networking protocol that allows your computer to 
communicate with the Internet. 

In order to configure TCP/IP on a Macintosh, you must have either 
Open Transport or MacTCP installed. You must also have a built-in 
Ethernet or a third-party Ethernet card and its associated drivers 
installed in your Macintosh. 

• �Go to the Apple Menu, select Control Panel, and select TCP/IP or 
MacTCP

• �In the TCP/IP or MacTCP/More window, select or enter information 
as shown in Figure 33:

Figure 33

	 - Connect Via: Ethernet 

	 - Configure: Using DHCP

	 - DHCP Client ID: Enter username

	 - IP Address: Will be automatically assigned

	 - Subnet mask: Will be automatically assigned

	 - Router Gateway Address: Will be automatically assigned

	 - Domain Name server address: Will be automatically assigned

	 - Starting domain name: Not able to change

	 - Ending domain name: Leave as is

• �Close the TCP/IP Control Panel and click Save to save the settings. 
If you are using Open Transport, you do not need to restart, 
although in some cases it may be necessary
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SECTION 6

E-mail Account Setup 

Before setting up the e-mail software on your computer, you need to 
change the temporary Primary Username and temporary Primary 
Password assigned to your qwest.net account to reflect what you 
wish to use. The temporary Primary User Name and temporary 
Primary Password are printed in the Qwest Choice™ OnLine welcome 
letter you received previously. The steps to personalizing your e-mail 
username and password are as follows:

1.	�With your browser, go to the URL: qwest.net/acct_mgmt/choice.cgi.

2.	�Log in using the temporary Primary Username and the temporary 
Password listed in your welcome letter.

3.	�Use the directions on this page to change your Username to one 
you would like to use.

4.	Select a unique Password that you can easily remember. 

E-mail Software Setup 

Which instruction you follow to set up e-mail on your computer 
depends on whether you are using Microsoft or Apple products.  
Use your new, personalized Username and Password to set-up your 
e-mail software. Instructions for each type of e-mail software follow.

Microsoft Outlook Express

To set-up Outlook Express, you need enter the following information:

•	 Username: your new, personalized Username

•	 Password: your new, personalized Password

•	 E-mail Address: username@qwest.net

•	 POP3 Server (or Incoming Mail Server): pop.dnvr.qwest.net

•	 SMTP Server (or Outgoing Mail Server): pop.dnvr.qwest.net

The steps to configure Outlook Express  
are as follows:
1.	�Launch Outlook Express by either clicking on the desktop Icon or 

by clicking on Start, then All Programs, then Outlook Express.

2.	�Click on Tools, then Accounts. Click Add and then click on Mail in 
the menu.

3.	�Where the e-mail address is requested, enter your new, 
personalized Username followed by @qwest.com (e.g. 
johnsmith@qwest.net), then click Next.
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4.	�Select POP3 as the incoming mail server type. Type pop.dnvr.
qwest.net where the Incoming Mail Server information is 
requested. Type pop.dnvr.qwest.net where the Outgoing Mail 
Server information is requested, then click Next.

5.	�Where the account name is requested, enter your new, 
personalized Username followed by @qwest.net. Where the 
password is requested, enter your new, personalized Password. 
Click the remember password box so that a check mark appears. 
The SPA box should remain unchecked.  Then click Next. 

6.	�If requested, click on the ‘Connect using my local area network’ 
button to highlight it, then click Next, then Finish. If there is no 
connection request, then click Finish. You may now begin sending 
and receiving your Qwest® E-mail.

Macintosh 

The steps to configure e-mail on a Macintosh are as follows:  

1. Launch Mail by selecting it from the dock.

2.	�If this is the first time you have opened Mail, enter the following 
information in the Mail Setup window: 

•	 E-mail address: your @qwest.net e-mail address

•	 Incoming Mail Server: pop.dnvr.qwest.net

•	 Mail Server Type: select POP3

•	� User Account ID: Your personalized Username (everything leading up 
to, but not including the @qwest.net part of your e-mail address)

•	 Password: your personalized Password

•	 Outgoing (SMTP) Mail Server: pop.dnvr.qwest.net 

Then click OK to begin using your Qwest e-mail.
3.	�If you were not presented with the Mail Setup screen, you will have 

to manually configure your Mail program. To begin, click Mail from 
the top menu, and select Preferences from the drop down list.

4.	On the Accounts screen, select the Add Account button.

5.�	�On the Account Type drop down menu, select POP3. Then enter your:

•	 Description with a descriptive title - for example “Qwest E-Mail”

•	 E-mail address with your @qwest.net e-mail address

•	 Full Name with your name 

•	 Incoming Mail Server with mail.qwest.net 

•	 Username with your personalized username and 

•	 Password with your personalized Password

Then select the drop down icon next to Outgoing  
Mail Server.
6.	�On the SMTP Server Options screen, enter pop.phnx.qwest.net as 

your Outgoing Mail Server. Make sure that the Server port is set to 
25, and then click OK to return to the previous screen.

7.	�Click OK when you return to the Account Information screen, and 
then close the Accounts window. You may now begin sending and 
receiving your Qwest E-mail.
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SECTION 7

Your e-mail account 

With your Qwest Choice™ OnLine service you can have more than  
one e-mail box within one Qwest Choice OnLine account. Additional  
e-mail boxes are known as subaccounts or secondary accounts. 
Choice OnLine Deluxe service includes five e-mail boxes. 

Adding a new e-mail box

Use this process either to add your free mailboxes or to purchase 
extra e-mail boxes. There are two steps to adding an e-mail box: 

1.	�Report the new e-mail box to the Qwest Choice OnLine server 
using the Account Manager. 

2.	Make changes to configure the new e-mail box on your computer. 

Instructions for these steps follow. 

Step One: Report the new e-mail box to the  
Qwest Choice OnLine server
•	� To open the Account Manager, go to the Qwest Choice OnLine 

home page that was specified during your installation. Click My 
Account, then click Account Manager

 
•	� The system will ask for a username and password. Be sure to 

sign in with the primary username and password; this is the only 
account that has the ability to create subaccounts

•	� Click the Add Subaccount button. If you have already added the 
e-mail subaccounts that are free with your service, a screen will 
appear about purchasing additional e-mail subaccounts

•	� Otherwise enter information as requested. Write down the new 
username and password, and keep them in a safe place. Be 
sure to write down the exact username and password you enter, 
paying special attention to uppercase and lowercase letters. 
Within 30 minutes, your new account will be able to send and 
receive e-mail

Step Two: Create the additional e-mail box  
on your computer

The instructions you follow to create the additional e-mail box on 
your computer using Outlook Express follow.
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Outlook Express 4.0

Once you have created an additional e-mail box, your new account on 
the server will be ready within 30 minutes. To access that new account, 
you must enter settings into Outlook Express on your computer.

Recording server information

Before setting up your new account in Outlook Express, you must first 
record your incoming and outgoing server information as follows. 

1.	Open Outlook Express. 

2.	From the Tools menu, select Accounts. 

3.	In the Internet Accounts window, click the Mail tab. 

4.	Select your primary account from the list. Click Properties. 

5.	�Select the Servers tab. Write down the information in the  
Outgoing Mail (SMTP) and Incoming Mail (POP3) boxes.  
Note: The information should be the same in both boxes.  
An example of what you will see is “pop.dnvr.qwest.net”. 

6.	Click OK.

Setting up an account 

To set up an account in Outlook Express, complete the following steps.

1.	�In the Internet Accounts window, click the Mail tab. Click Add  
and select Mail. This will launch the Internet Connection Wizard. 

2.	�In the Internet Connection Wizard window, enter the following 
information where prompted:

a.	�Your Name: Enter the full name for your additional e-mail account 
in the Display name box. Click Next. 

b.	�Internet e-mail Address: Enter the e-mail address for your 
additional e-mail account in the e-mail address box. Click Next.

c.	�E-mail Server Names: Select POP3 for the incoming mail server 
type. Enter the mail server information you recorded earlier in the 
Incoming Mail (POP3 or IMAP) server and Outgoing mail (SMTP) 
server boxes. Note: The information should be the same in both 
the incoming and outgoing mail server boxes, such as “pop.dnvr.
qwest.net”. Click Next.

d.	�Internet Mail Log on: Select “Log on using:” and enter your 
additional e-mail account’s username in the POP account name 
box. Enter the password in the Password box. Click Next.

e.	�Friendly Name: Clear the Internet mail account name box and 
enter the full name for the additional e-mail account. Click Next.

f.	� Choose Connection Type: Select “Connect using my phone line” 
and click Next.

g.	�Dial-Up Connection: Select “Use an existing dial-up connection” 
and select the primary account’s qwest.net connection. Click 
Next.

3.	�CIick Finish to close the Wizard. Your new e-mail account will  
now appear in the Internet Accounts window. Click Close.
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Changing your account password

To change your Qwest Choice™ OnLine password, complete the 
following steps.

1.	�From your network home page (see the My Settings page for the 
address for your locale specific homepage), click on the blue My 
Account icon, located below the selection bar.

2.	Click on Account Manager.

3.	Log on using your primary account username and password.

4.	Select the e-mail account that the new password will pertain to.

5.	Click on the Change Password button.

6.	Click in the first box.

7.	�Type in the new password. Note: Check that the password meets 
the requirements.

8.	Click on the second box.

9.	Type in the new password a second time.

 10.	Click on the Submit button.

At this point the password has been submitted. Allow up to 30 
minutes for this change to take effect. The previous password will 
continue to be valid until the new password takes effect.

                                       Using E-mail
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SECTION 8

Understanding newsgroups

Newsgroups provide access to information on any topic of interest. 
This section helps you set up and manage newsgroups using your 
Web browser. 

Newsgroups in Microsoft  
Outlook Express 

Reading newsgroups can be done from Outlook Express, the same 
interface used for your e-mail. 

Getting started

Set your preferences to use the qwest.net news server as follows:

1.	Within Outlook Express, go to Tools > Accounts. 

2.	Select the News tab. 

3.	�If news.qwest.net is not listed as your server, click Add -> News... 
followed by Internet Connection Wizard. 

4.	�Enter the name you want to use when you post a message or 
send e-mail and click the Next button. 

5.	�Enter an e-mail address so people can reply to your e-mail 
message and click Next. 

6.	�Enter news.qwest.net when prompted for your News (NNTP) 
Server. We do not require that you log on, so leave that box 
unchecked and click Next. 

7.	Click Finish to save your changes. 

8.	�If this is the only newsgroup listed, it will be your default 
newsgroup. If others are listed, you can set this as your  
default by making sure news.qwest.net is highlighted and 
clicking the Set as Default button. 

9.	Click Close. 

 10.	�Click Yes to download newsgroups. 
Note: The first time that you choose this, Outlook Express will 
download the names for all 35,000+ newsgroups. Depending  
on your access speed, it may take approximately 10 minutes  
for this to finish.

 11.	Click the OK button to close the window. 
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Finding and subscribing to newsgroups

Once you finish setting your preferences, the news server should 
appear as a folder in Outlook Express. The folder will be labeled: 
news.qwest.net. To find newsgroups you may be interested in, 
complete the following steps.

1.	Click on news.qwest.net. 

2.	�If you are not already subscribed to any newsgroups, Outlook 
Express will ask you if you want to see a list of available 
newsgroups. Click the Yes button. 

3.	Find newsgroups you are interested in.

4.	�Once you see the list of newsgroups, you can search for a 
topic that you are interested in by typing the subject of interest 
into the “Display newsgroups” box beneath near the top of the 
Newsgroups Subscriptions window.

5.	�Enter a subject in the Display newsgroups box.  
Note: Outlook Express Version 5.0 will begin searching after you type 
in your subject. For example, a search for “antiques” might return:  
alt.antiques.delaware.joe 
rec.antiques 
rec.antiques.bottles 
rec.antiques.radio+phono

To subscribe to a newsgroup, complete the following steps:

1.	�Select the newsgroup you are interested in, such as  
rec.antiques.bottles.

2.	�Click Subscribe. (You can subscribe to additional newsgroups  
by repeating these two steps.) 

3.	�Click OK once you have subscribed to all the newsgroups that 
interest you. 

Reading and participating in newsgroups

Read the newsgroup as you would your e-mail within Folders:

1.	�Using Outlook Express, scroll down to the name of the newsgroup 
you subscribed to (rec.antiques.bottles) and double-click on it. 

2.	�Using Internet Explorer, select Tools -> Mail and  News -> Read 
News. This will open Outlook Express. 

3.	�Scroll down to the name of the newsgroup you subscribed to 
(e.g., rec.antiques.bottles) and double-click on it. 

You can read and post messages just like you read and reply to e-mail: 

1.	�To send a message to the newsgroup, click on Reply Group. 

2.	To respond to the person, select the Reply button.
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SECTION 9

Understanding Web space

With your Qwest Choice™ OnLine account you can publish your own 
Web pages using an FTP client, Microsoft Internet Explorer, Microsoft 
FrontPage 98, Microsoft FrontPage 2000 or Netscape Composer. You 
can also edit your Web pages locally or directly on the server, and 
get information on your disk space. 

Important: Only the primary account user can create a Web  
space and publish pages. The primary account is the one that  
was designated as primary during your installation. 

Note: Qwest® will not allow posting of obscene or otherwise 
offensive material, as determined solely at our discretion. Qwest 
will not allow posting of materials that infringe or misuse our trade 
names, trademarks or copyrights. Qwest is not responsible for the 
content of your Web site, including, but not limited to, materials that 
may infringe on other’s marks. Qwest reserves the right, at its sole 
discretion, to remove Web site content on its servers that it finds to 
be obscene, offensive or otherwise unlawful. Additional information 
is available on the Terms and Conditions page. 

FTP and HTTP support

In addition to supporting hypertext transport protocol (HTTP),  
Qwest Choice OnLine supports File Transfer Protocol (FTP). You  
may use either method to publish and modify your Web pages  
on the qwest.net Web site server. 

Getting started

Before you can publish your first Web page, you will first need to 
create your Web space on our server. 

1.	From your locale-specific home page, click on My Account. 

2.	�Click on the link Create Your Web Space. Sign in using your 
primary username and password, and follow the instructions  
on that page. 

3.	�Be sure that you have the URL for your Web space on hand 
because you will need this to upload your page. The format of  
your URL should be http://www.users.qwest.net/~username

Next, create the name index.html for your main Web page (this  
is so that your main Web page will automatically load when the 
address for your Web site is entered). Other pages you create that 
are linked to this main page may be named anything. 
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Using FTP (Experienced Users) 

Qwest.net offers FTP access to our Web server. We will set up your 
primary account username and password on our FTP server to allow 
you to access your Web site files.

Use the following information to configure your FTP client or software:

•	 Host name (or Host): ftp.users.qwest.net 

•	 Username: Your primary account username 

•	 Password: Your primary account password 

When you have successfully connected to the qwest.net FTP 
server, you will see the message “Welcome to qwest.net FTP Web 
Publishing.” You can now use your FTP software to manage the files 
in your qwest.net Web space.

The qwest.net Web page server will disconnect after 15 minutes 
of inactivity. Depending upon your FTP client software, you may 
increase this setting to a maximum of 60 minutes. As long as you 
remain active, the FTP server will maintain the connection.

Using Microsoft FrontPage 98 

Qwest.net now supports Microsoft FrontPage 98 extensions.

1.	In FrontPage Explorer, open the Web site that you want to publish.

2.	�Click the Publish button on the FrontPage Tool bar. The dialog box 
appears in Figure 45.

3.	�Add the URL to publish your site as shown, making sure to add 
your username after the tilde (~):  
http://www.users.qwest.net/~yourusername.

Figure 45

4.	�Do not click the Secure connection required (SSL) box. (SSL is  
not currently supported in the qwest.net environment.) 

5.	�Enter your username and password (the same username and 
password you use to access qwest.net). 

6.	Click OK. 

The Publish FrontPage Web dialog box will close and there will be a 
pause as FrontPage contacts the Web server. Note: FrontPage now 
begins copying all your Web site files from your computer to the Web 
server. Depending on the size of your Web site and the speed of your 
Internet connection, this process may take a few minutes.

After your files have been copied, the FrontPage Status Bar will 
display the message “Published to,” followed by the destination URL. 
Your site is now ready to view. 

Using Your Web Space
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To view your Web site you can either: 

1.	�Open a browser and type in your site URL (e.g., http://www.users.
qwest.net/~yourusername/) or

2.	�Open the site by highlighting the site from FrontPage Explorer and 
double-clicking. 

Using Microsoft FrontPage 2000

Qwest.net supports Microsoft FrontPage 2000 extensions. In addition 
to the following instructions, FrontPage FAQs are also available.

1.	�In Microsoft FrontPage, open the Web site that you want to publish.

2.	�Select File -> Publish Web, or click the Publish Web icon on the 
FrontPage toolbar. The dialog box shown in Figure 46 will appear.

3.	�Add the URL address to publish, using the format http://www.
users.qwest.net/~yourusername. 

4.	�Click the appropriate radio buttons to publish or update your Web site.

5.	�“Publish changed pages only” is the default. This feature will 
publish your entire site the first time.

Figure 46

6.	�“Publish all pages” overwrites pages already published. This 
feature is used to update your entire site. 

7.	�“Include subwebs” should be checked if you have any on your 
Web site.

8.	�Do not select Secure connection required (SSL is not currently 
supported in the qwest.net environment).

9.	�Enter your username and password (the primary username 
and password).

 10.	Click Publish.

Note: A status dialog box will appear that tells you what is going on. 
When you update your Web site, a FrontPage dialog box notifying 
you that a file you are publishing will replace a current file on the 
server will appear and ask whether that is what you want to do. The 
size of your Web site files will determine the time it takes for your 
Web site to update. It could take several minutes.

Figure 47

Once all the files are published, the dialog box shown in Figure 47 
will appear: Clicking on the hyperlink opens your Web site in your 
default browser. Clicking the Done button takes you to the FrontPage 
screen you used to publish your site.

Using Your Web Space
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Using Web Site Manager

You can use your FTP software or you can use the Web Site Manager 
to see how large your files are and how much space remains.

1.	�Open the Web Site Manager (click the My Account link from the 
home page).

2.	�Click Maintain Your Web Site to view your file sizes and disk space.  

Deleting a Web page
1.	�Open the Web Site Manager (click the My Account link from your 

locale-specific home page).

2.	Click Maintain Your Web Site. 

3.	�Enter the username and password of your primary account. (Only 
primary account users can delete Web pages.) 

4.	�To delete a file, click in the box located to the left of the file name 
in the Delete? column. (You may delete files one at a time or 
select several files to delete.) 

5.	�Once you finish selecting the files you want to delete, click on the 
Delete Selected Files button. 

6.	�A delete confirmation screen will appear. Double check the 
list of files you marked for deletion. Files accidentally deleted 
cannot be restored. 

7.	�If the delete list is correct, click Yes to delete the files. Otherwise, 
click No to cancel the delete request. 

8.	�After the delete request is complete, the Web Site Manager will 
display a list of the files that remain. 

9.	�When you are finished deleting files, click the Back button, close 
the window or go to a new URL location.
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Frequently Asked Questions

SECTION 10

Q:	Will I miss any e-mail messages while my computer is off? 

A: �Absolutely not. Just like the brick-and-mortar post office, our 
mail system works around the clock to receive your mail when 
it arrives. Just as you don’t have to be at your mailbox when a 
letter arrives, your computer doesn’t have to be on to receive 
mail. E-mail messages remain in your electronic mailbox on the 
qwest.net server until you turn on your computer and check your 
e-mail. Then your mail is sent to and stored on your computer 
for you to read, print and delete as you like.

Q:	Does everyone in the family have to share the same e-mail? 

A:	�No! You receive separate e-mail accounts in association with one 
primary account. See Section 1 for more information.

Q:	Why can’t I get my e-mail?

A:	�As soon as you install and configure your e-mail service information, 
you are able to receive e-mail with the primary account you 
registered at the e-mail address you chose. Instructions follow on 
how to check your e-mail and e-mail settings. 

If you are having trouble receiving your e-mail:

You may want to check your e-mail settings. Your e-mail settings are 
configured properly at the time of registration/installation and would 
not have changed without your specifically changing them. Exercise 
caution with e-mail settings, and do not make any changes you are 
not completely certain about.

Q:	Is my identity protected while I’m using the Internet? 

A:	�Qwest.net does not make any of your account information 
available for public access. But you’re free to pass around any 
information about yourself that you wish to share with other 
Internet users. We recommend that you exercise great caution 
when giving out private information because that information  
can travel quickly.

Q: �When using Dial-Away Roaming, why do I sometimes have 
trouble connecting to the Internet?  

A: �One possible reason may be that your modem is not connecting 
at a stable rate. An effective solution is entering three commas 
(,,,) after the dial-in number in your dialer. You can also check 
to see that your connection set-up is configured correctly. 
Instructions vary depending on the software that you have:
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Windows 98SE/XP  
1.	�Double-click the “My Computer” icon on your desktop, and then 

double-click the “Dial Up Networking” icon. 

2.	�Right-click the qwest.net dialer connection and select “Properties.” 

3.	�Select the General tab. In the Phone number box, click after the dial-
in phone number and enter three commas (,,,) after the number. 

4.	�Select the Server Types tab. Make sure that only the Enable 
software compression and TCP/IP check boxes are selected. 

5.	Click OK. 

Windows NT 4.0    
1.	�Double-click the My Computer icon on your desktop, and then 

double-click the Dial Up Networking icon. 

2.	�Select the drop-down arrow next to the Phonebook entry to dial 
box and select the dialer connection you would like to change 
from the drop-down list. Click More and then click Edit entry and 
modem properties. 

3.	�Select the Basic tab. In the Phone number box, click after the dial-
in phone number and enter three commas (,,,) after the number. 

4.	�Select the Server tab. Make sure that only the Enable software 
compression and TCP/IP check boxes are selected. 

5.	�Click OK. Click Dial to save the change and connect to qwest.net. 

6.	�From the File menu, select Configuration. Select the dialer for 
qwest.net from the list, which makes this dialer active. 

MacIntosh   
1.	�Open the Apple menu. Select Control Panels and then select 

Remote Access. (If you are running an OS version earlier than 8.5, 
you will not see Remote Access as an available selection. Use the 
instructions that follow these for the Free PPP Set-up selection.) 

2.�	�The Remote Access window appears for the dialer that is active. 
In the Number box, click after the dial-in phone number and enter 
three commas (,,,) after the number. Click Save. 

For users running an OS version 2 earlier than 8.5: 

1.	�Open the Apple menu. Select PPP Set-up or Free PPP Set-up — make 
sure the arrow points down. 

2.	�On the General tab, make sure the following Allow Applications  
to Open Connection and Disconnect if Idle [this is optional]  
are checked.

3.	�Click the Accounts tab: the label should show qwest.net or your 
username (yourname@qwest.net). 

4. Select Edit. 

5. For Server Name choose qwest.net. 

6. Make sure the local dial-in number is correct. 

7. Click OK. 

8. Click the General tab again. Select TCP IP. Click OK.    

9. Restart your computer and try connecting again. 
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Q:	Where do I find a list of local dial-in numbers? 

A:	�From the default Qwest Choice™ OnLine home page, click on the 
Help link.

Q:	How do I link my domain name to my qwest.net account? 

A:	�You must be a Qwest Choice™ OnLine customer with an active 
user ID and password in order to use your own domain. You 
can get to this information by clicking on the My Account link 
from the default Qwest Choice OnLine home page. Choose Link 
Your Domain Name to Your Web Site, sign in using your primary 
username and password, and follow the instructions that appear.

Q:	�I do not remember my password. What should I do? 

A:	�Most questions can be answered in the changing your password 
and changing your Username Help sections. If you are still having 
problems, please contact technical support.

Frequently Asked Questions
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Safety Information

SECTION 11

Important safeguards about your  
Digital Equipment

Accessories. Do not place Qwest-provided equipment on an 
unstable cart, stand, tripod or table. The product may fall, causing 
serious injury and/or serious damage to the product.

Three-wire grounding. Qwest-supplied equipment may have a 
three-wire grounding-type plug, a plug having a third grounding pin. 
This pin will only fit into a three-pin grounding-type outlet. If you do 
not have a three-wire grounding type outlet, contact an electrician  
to replace your outlet.

Attachments. Do not use attachments that are not recommended, 
because they may create a hazard.

Cleaning. Do not use liquid or aerosol cleaners to dust Qwest-supplied 
equipment. Use a cloth lightly dampened with water for cleaning.

Damage requiring service. Unplug Qwest-supplied equipment 
from the wall outlet and refer servicing to qualified service 
personnel if: 

•	 The power supply cord or plug is damaged

•	 Liquid has been spilled or objects have fallen into the equipment

•	� The equipment does not operate normally according to the 
operating instructions

•	� The equipment has been dropped or the housing has been damaged

•	 The equipment exhibits a distinct change in performance

Ground or polarization. Qwest-supplied equipment may have 
a polarized alternating current line plug (a plug having one blade 
larger than the other). This plug will fit into the power outlet in only 
one way. This is a safety feature. If you are unable to insert the plug 
fully into the outlet, try reversing the plug. If the plug should still fail 
to fit into the outlet, contact an electrician to replace your outlet.

Object and liquid entry. Never push objects of any kind into this 
product through openings as they may touch dangerous voltage 
points or short out parts that could result in a fire or electrical shock. 
Never spill liquid of any kind on the Qwest-supplied equipment.

Overloading. Do not overload wall outlets and extension cords, 
because this can result in fire or electrical shock.
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Power cord protection. Power cords should be routed so they are not 
likely to be walked on or pinched by items placed on or against them; 
pay particular attention to cords in plugs, convenience receptacles and 
the point where the plugs exit from Qwest-supplied equipment.

Power socket outlet. Use a power socket outlet located near the 
Qwest-supplied equipment that is easily accessible.

Power sources. This product should be operated only from the 
type of power source indicated on the marking label. If you are not 
sure what type of power is supplied to your home, consult your local 
power company. For equipment intended to operate from battery 
power or other sources, refer to the operating instructions.

Safety check. On completion of any service or repairs to the product, 
ask the service technician to perform safety checks to determine 
that the Qwest-supplied equipment is operating properly.

Servicing. Do not attempt to service Qwest-supplied equipment yourself. 
Opening or removing covers may expose you to dangerous voltage 
or other hazards. Refer all servicing to qualified service personnel.

Ventilation. Slots and openings in the Qwest-supplied equipment 
are provided for ventilation, to ensure reliable operation of the 
product and to protect it from overheating. The openings should 
never be blocked by placing the equipment on a bed, sofa or similar 
surface that may block openings. Equipment should never be placed 
near or over a radiator or heat register, or in a built-in installation 
such as a bookcase or rack unless proper ventilation is provided.

Water and moisture. Do not use this product near water; for 
example, near a bath tub, wash bowl, kitchen sink or laundry tub,  
in a wet basement or near a swimming pool.

Safety

This section reviews important safety concepts for working with the 
optical and electrical equipment covered in this guide.

Warning Labels

The following table describes important safety warning notices that 
that may be located on the back of Qwest supplied equipment.

Symbol Type of Notice Problem 
Prevented

c Electric shock hazard Bodily injury

Ground symbol  
(Ground terminal as  
specified, refer to UL  
1950 CSA C22.2 No. 950)

Bodily injury

m Caution Bodily injury

Failure to heed these warnings and similar danger, caution or 
warning notices can result in serious personal injury, service 
interruption and equipment damage.

Repairs

If your unit is in need of repair, contact Qwest® for repair or replacement.

WARNING! Disconnect the unit before servicing.

Safety Information
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FCC statement of compliance

Qwest-supplied equipment complies with Part 15 of the FCC Rules. 
Operation is subject to the following two conditions: (1) this device 
may not cause harmful interference, and (2) this device must accept 
any interference received, including interference that may cause 
undesired operation.

Note: Qwest-supplied equipment has been tested and found to 
comply with the limits for a Class B digital device, pursuant to 
Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accordance with 
the instruction manual, may cause harmful interference to radio 
communications. However, there is no guarantee that interference 
will not occur in a particular installation. If this equipment does 
cause harmful interference to radio or television reception, which 
can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the 
following measures:

•	 Reorient or relocate the antenna

•	 Reorient or relocate the receiving antenna

•	 Increase the separation between the equipment and receiver

•	� Connect the equipment into an outlet on a circuit different from 
that to which the receiver is connected

•	 Consult the dealer or an experienced radio/TV technician for help
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What Qwest Supports

SECTION 12

Standard installation services

The Qwest Choice™ TV Standard Installation package includes 
installation and connection of the following devices by an authorized 
Qwest® technician: 

•	 One set-top terminal

•	 Activation of one outlet

•	 One VCR or DVR hookup

•	 One stereo system hookup

Note: Qwest technicians are not authorized to move customer 
furniture and may be unable to complete the installation if moving 
furniture is required.

Premium installation services

In addition to the standard installation services, premium installation 
services are available for an additional charge. Examples of 
additional installation services are:

•	 Additional set top terminals or remote controls

•	 Activation or installation of additional outlets

•	 Additional VCR connections

•	 Additional stereo system connections

•	 Additional inside wiring between interior walls

Other cable or satellite services

Qwest technicians will not install Qwest Choice TV on a TV set that 
is connected to another cable service (such as Comcast or Cox) or 
digital satellite service (such as DIRECTV or DISH Network).

Qwest provides no customer support, assistance or repair service for 
customer TVs that are connected to other cable or satellite TV services.

Customer support and repair service

Qwest provides customer support by telephone for the components 
of the Qwest Choice TV system supplied by Qwest.

For problems requiring the dispatch of a Qwest service technician, 
all repair work that is a result of Qwest network or Qwest equipment 
problems will be performed free of charge.

Qwest Choice TV customers will be charged for the repair or 
replacement of any Qwest Choice TV equipment or installation 
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components that are caused by customer error, misuse, abuse or 
negligence as determined by Qwest at our sole discretion. No such 
repair service will be completed without prior authorization from the 
Qwest Choice TV subscriber.

Support for customer equipment

The Customer Support Center and service technicians are not 
responsible for providing assistance with audio, video and electronic 
equipment other than the Qwest Choice TV components supplied 
by Qwest. If you have questions about other devices, you should 
contact the original dealer or manufacturer of your equipment.

Such nonsupported devices and components include:

•	 TVs and original TV remote controls

•	 VCRs and original VCR remote controls

•	 Home theater, stereo and surround sound systems

•	 DVD players and original DVD remote controls

•	 Digital Video Recorders (such as TiVo or ReplayTV)

•	 Video game consoles

•	 Internet TV devices (such as WebTV or AOL TV)

•	 Universal remote controls not supplied by Qwest

Customer Support

If you need help on issues not covered by this manual, want to make 
changes to your account, or have questions about your bill, or if your 
Qwest Choice TV service does not appear to be working properly, 
just give us a call. Our representatives can answer your questions 
and are frequently able to help you troubleshoot and fix your problem 
right over the phone. If you still require on-site assistance, a Qwest 
technician will be dispatched to repair your service.

Denver: 1 303-383-9400 
Salt Lake Valley: 1 801-741-0300




